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Microsoft Access 2000 is a relational database management system where data are stored and organized.  

Key Definitions

	Criteria
	The set (or sets) of limiting conditions that obtain a specific set of records in the query or filter results.

	Crosstab Query
	A query that calculates a sum, average, count, or other type of total for data that is grouped by two types of information—one down the left side of the datasheet and another across the top.

	Database
	A structure of tables where information is stored and analyzed.

	Data type
	The type of data stored in a table field.  Access provides a drop-down list that contains all types of data that can be assigned to a field.  These fields include text, memo, and number.

	Description
	An explanation of the current column or field property.

	Field
	A column in a database table.

	Field name
	The name of the current column or field.  Field names can be up to 64 characters long.

	Form
	A way to input and view the data in a database.

	Macro
	An action or set of actions used to automate tasks.

	Module
	A collection of declarations, statements, and procedures stored together as one unit used to customize a database.

	Primary Key
	A field that Access uses to determine the order in which records are displayed.

	Query
	A question about the data stored in tables, or a request to perform an action on the data.

	Record
	A row in a database table.

	Relational Database
	A database that allows more complex data that can be stored in tables.  Relationships between information contained in multiple tables can be defined allowing for simple to complex data manipulation and analysis.  

	Report
	A summarized account of the data.

	Show
	Indicates whether or not you want the field to be displayed with the data results.

	Sort
	Specifies how you would like to see the information displayed, either in ascending or descending order, or in no particular order.

	Table
	The basic structure of a relational database.  The table stores data in records (rows) and fields (columns).


The Access 2000 Main Window
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Access 2000 Menus

File Menu
	
	New
	Allows you to create a new database.

	
	Open
	Allows you to open a previously saved database.

	
	Get External Data
	Allows you to update linked data from an external source.

	
	Close
	Allows you to close the current database.

	
	Save
	Allows you to save changes to the current opened database.

	
	Save As
	Allows you to save the database to a different name.

	
	Export
	Allows you to export data to a different file or format.

	
	Page Setup
	Allows you to select options for setting up and printing your database.

	
	Print Preview
	Displays the open database objects as it appears when printed.

	
	Print
	Allows you to choose print options and initiate printing for the open database.

	
	Send To
	Allows you to choose different delivery methods for the database.

	
	Database Properties
	Provides information and general statistics about the open database.

	
	Recent Documents
	Provides a list of recently opened database files. 

	
	Exit
	Closes the Access 2000 window.

	
	
	


Edit Menu

	
	Undo/Can’t Undo
	Allows you to reverse the last action taken.

	
	Cut
	Allows you to remove a selection from the database.

	
	Copy
	Allows you to place a copy of a selection on the clipboard

	
	Paste
	Allows you to paste a cut or copied selection within the database.

	
	Paste Special
	Allows you to paste a selection with specified formats.

	
	Paste as Hyperlink
	Allows you to place cut or copied text and graphics as a hyperlink.  

	
	Paste Append
	Allows you to determine which types of data can be pasted to specific fields.

	
	Delete
	Allows you to delete a selection.

	
	Delete Record
	Allows you to delete a whole record (or row).

	
	Delete Column
	Allows you to delete a whole column (or field).

	
	Select Record
	Allows you to select a whole record.

	
	Select All Records
	Allows you to select all records at one time.

	
	Find/Replace
	Allows you to search for specific text/and replace with new text.

	
	Go To
	Allows you to quickly go to a specific record within the database.

	
	OLE/DDE Links
	Allows you to modify defined links within a table.


Access 2000 Menus

View Menu
	
	Design View
	Allows you to switch to the design view of a database object.

	
	Form view
	Allows you to switch to the open form view of a database.

	
	Datasheet View
	Allows you to switch to the open datasheet view of a database.  

	
	Subform Datasheet
	Allows you to open the sub-forms of a datasheet.

	
	Properties
	Allows you to view the properties of the database object.

	
	Toolbars
	Provides access to the available toolbars.

	
	Zoom
	Allows you to set the zoom options.

	
	Pages
	Allows you to work with viewing data as it would be viewed as a Web page.


Insert Menu

From the Database Window

	
	From the Database Window, Reports Window, or Query Window
	Allows you to insert a new database object.



	
	From the Table Window
	Allows you to add new records, columns, and spreadsheet options.

	
	From the Forms Window
	Allows you to add new records.


Access 2000 Menus

Tools Menu
	
	Spelling
	Allows you to check spelling errors in the data.

	
	AutoCorrect
	Allows you to automatically correct common misspellings.

	
	Office Links
	Allows you to merge data with other Microsoft products.

	
	Online Collaboration
	Provides access to create an online discussion about the database.

	
	Relationships
	Allows you to establish and edit relationships between tables and queries.

	
	Analyze
	Allows you to perform analyses to the database.

	
	Database Utilities
	Provides access to database utilities.

	
	Security
	Allows you to specify security options for the database.

	
	Replication
	Allows the replication of database objects.

	
	Startup
	Allows you to choose database startup options.

	
	Macro
	Provides access to creating automated tasks and running these tasks.

	
	ActiveX Controls
	Allows you to register/unregister ActiveX controls within the database.

	
	Add-Ins
	Allows you to install additional Access features.

	
	Customize
	Allows you to customize the Access icons and features.

	
	Options
	Provides access to Access features.


Window Menu

	
	Tile Horizontally
	Allows you to tile the windows horizontally.

	
	Tile Vertically
	Allows you to tile the windows vertically.

	
	Cascade
	Allows you to overlap all open database windows.

	
	Arrange Icons
	Allows you to arrange icons of a window.

	
	Hide/Unhide
	Allows you to hide/unhide open windows.

	
	Open Database Windows
	Displays a list of all open database windows.


Help Menu
	
	Microsoft Excel Help
	Provides access to Microsoft Access help.  Displays the Office Assistant where you can type in the information you are looking for.

	
	Show/Hide the Office Assistant
	Turn on/off the Office Assistant.

	
	What’s This?
	Allows you to click on a screen element to obtain general description about the function.

	
	Office on the Web
	Provides access to online help for Microsoft Access.

	
	Detect and Repair
	Provides automatic repairs to the Access program when files have been damaged.

	
	About Microsoft Access
	Provides licensing and copyright information about the Access program installed on the computer.


Database Fundamentals

Databases provide a simple way to keep track of information.  Information is stored in tables.  The tables can be used in multiple ways to analyze and report the data.  A database stores related data tables and other data objects including:  queries, reports, forms, and macros.  Each database object is stored within a single file named <filename.mdb>.

Database objects include:

Table:  A table stores the data in rows and columns.  You can use a table to input, view, and print data.

Form:  A form allows information to be input and viewed in a user-friendly format.

Query:  A query will quickly locate and display information based on user-defined criteria.

Report:  A report compiles the data into an organized format used for viewing and printing.

Microsoft Access allows you to:

· Build a database using multiple tables and queries.

· Work with data within a table or by using a form.

· Query information about data.

· Create a report using a database.

· Create form letters and mailing labels.

· Sort information within tables.

· Write macros to easily manipulate the data within a database.

The following steps are recommended building blocks for creating a relational database.

Step 1:  Determine the purpose of the database.

Preparing and planning is the first step in designing a database.  It is important that you outline the purpose of the database and how you are going to use it.  Before designing the database structure, look at your data and make some decisions regarding the types of information you want from the database.  From that, you can decide how you are going to build the database.  It is a good idea to know what type of reports you'd like to produce using the database.  

Step 2:  Determine the tables you need.

All of the database objects will draw upon the data contained in the tables, so its important to design your tables keeping the following fundamental design principles in mind: 

· A table should not contain duplicate information, and information should not be duplicated between tables.  In this respect, a table in a relational database differs from a table in a flat-file application such as a spreadsheet. 

· Each table should contain information about one subject.

Step 3:  Determine the table fields. 

Each table contains information about the same subject, and each field in a table contains individual facts about the table's subject.  When sketching out the fields for each table, keep these tips in mind: 

· Relate each field directly to the subject of the table.

· Include all the information you need.

· Store information in its smallest logical parts (for example, First Name and Last Name, rather than Name). 

Database Fundamentals

Step 4:  Identify the primary key.

Tables should include a field or set of fields where information is uniquely identified and stored.  Access allows users to designate this unique field using the primary key.  The primary key designation will uniquely identify each record in a table.  The primary key is used when building relationships to foreign keys in other tables.

Step 5:  Determine the relationships between tables.

A relationship is an association established between common fields (columns) in two or more tables.  A relationship works by matching data in key fields—usually a field with the same name in both tables. 

Step 6:  Refine your design.

After you have built the tables, fields, and relationships you need, look over your outline and determine if there are any gaps.  If you find gaps, change your database design before filling in the data.  At this point, you can test your design and build initial drafts of your forms and reports to make sure they work with the data you expect to use.

Step 7:  Enter data and create other database objects.

After you have refined the database design, including the table structure and other database objects, it is time to enter data.  Based on the way you created your database, you can either enter data directly into the table structure or use a form.  Supplementary database objects can always be added during this step.

Database Pointers
· To work with all the objects within a database, use the Database window.  Under objects, click the type of Object you want to work with, from the right side window, choose the specific database object.  Use the New button on the Database window or the create options at the top of the list to create new objects.  Use the Design button on the Database window to modify existing database objects.

· After you have created the table structure, and generated a form, you can work with tables or forms interchangeably.  Because tables are displayed in rows and columns it makes it sometimes difficult to read so using a form makes it easier to input and look at data.  Working with forms is a user option; if you feel comfortable working solely in the table structure there is no need to generate a form.

· When storing your data, create one table for each type of information that you track. You can then bring the data from multiple tables together in a query, form, report, or data access page, or you can even define relationships between the tables.

· You can find and retrieve just the data that meets conditions that you specify, including data from multiple tables, you can create a query. A query can also update or delete multiple records at the same time, and perform predefined or custom calculations on your data.

· You can analyze your data or present it a certain way in print by creating a report. 

Creating a Database

Database Wizard

You can create a databases and database objects where you will be asked to define your database settings through a step-by-step process.

To create a database using the Database Wizard:

1. When Microsoft Access first starts up, an automatic dialog box prompts you to create a new database or open an existing one.  Select Access Database Wizards, Pages and Projects, and then click OK.  

2. On the Databases tab, double-click the type of database you want to create.

3. Specify a name and location for the database.

4. Click Create to start defining your new database.  

To create a database without using a wizard:

1. When Microsoft Access first starts up, an automatic dialog box prompts you to create a new database or open an existing one.  Select Blank Database, and then click OK. 

2. Or if you have already opened a database or closed the dialog box that displays when Microsoft Access starts up, click New Database [image: image2.bmp] on the toolbar, and then double-click the Blank Database icon on the General tab. 

3. Specify a name and location for the database and click Create. 

4. After you hit create, you will choose how you want to create your table.  


Saving a Database 

To save a database:
1. If you are saving a database object for the first time, type a name in the Save As dialog box, and then click OK.  

2. Access automatically saves and updates the data each time you close a dialog box within the program, additionally each time you close the application the latest changes are saved.

Working With Tables

The basic building block of a database using Microsoft Access is the table.  A table is a collection of data about a specific topic.  A database can contain many tables; these can be linked together to build relationships or can be used alone to analyze data.  Again, The key to successful database building is planning.  Ask yourself:  What data do I need to manage?  What do I need to do with the data?

Notes:

· A table organizes data into columns and rows.  The top row, or header row of a table, identifies the type of data contained within the rows under each column.  

· The data stored in columns are called fields.  A field is simply a piece of information about something or someone.  

· The data stored in rows are called records.  A table holds all the data records and should not hold more than one type of record.  

· Each record in a table contains all the information about a single subject.

· Having data organized is not important when using Access.  With the built-in features Find and Queries, you can view information in any organized format with just the click of a button.

Design View

Creating a table in design view is similar to entering data in a blank datasheet or table—much like adding data to a spreadsheet.  When you save the new datasheet, Microsoft Access evaluates the data entered and automatically creates appropriate field types and formats.  Also, you can insert additional columns or rename columns in a table in datasheet view at any time.
To create a new table in Design view:

1. Select the tab labeled Create Table in Design view.

2. Click Open. 

3. Define each of the fields in your table.  Remember, the fields in the table are the columns; these headers will be your column headers.  

4. After you have defined the fields click the Close button in the top right corner.  

5. You will be prompted to save the table.  Input a table name and click OK.
6. Access asks you if you want to create a primary key.  If you have entered data that can be used to uniquely identify each row in your table, such as part numbers or ID numbers, click No and you can assign the primary key to a unique field.  Otherwise, click Yes.  If you click Yes, an AutoNumber field is set as the primary key.

7. Follow the steps below to designate the primary key.  (Note:  You don't have to define a primary key, but it's usually a good idea.)

Working With Tables

Microsoft Access will assign data types to each field based on the kind of data entered.  Carefully selecting the data fields saves time and effort.  The following table provides descriptions for data fields:

	Data type
	Description

	Text
	Text or combinations of text and numbers, such as addresses.  Also, numbers that do not require calculations, such as phone numbers, part numbers, or postal codes.  Up to 255 characters.  Microsoft Access only stores the characters entered in a field; it does not store space characters or unused positions in a Text field.  To control the maximum number of characters that can be entered, set the FieldSize property.

	Memo
	Lengthy text and numbers, such as notes or descriptions.  Up to 64,000 characters.

	Number
	Numeric data to be used for mathematical calculations, except calculations involving money (use Currency type).  Set the FieldSize property to define the specific length.

	Date/Time
	Dates and times. 

	Auto Number
	Unique sequential (incrementing by 1) or random numbers automatically inserted when a record is added.

	Yes/No
	Fields that will contain only one of two values, such as Yes/No, True/False, On/Off.

	OLE Object
	Objects (such as Microsoft Word documents, Microsoft Excel spreadsheets, pictures, sounds, or other binary data) can be created in other programs using the OLE protocol, that can be linked to or embedded in a Microsoft Access table.  You must use a bound object frame in a form or report to display the OLE object.

	Lookup Wizard
	Creates a field that allows you to choose a value from another table or from a list of values using a combo box.  Choosing this option in the data type list starts a wizard to define this for you.


Primary Key

A primary key is a field or set of fields that uniquely identify each record stored in the table.  It is important to designate the table’s primary key field because it helps to prevent duplicate records from being entered into the database.  An AutoNumber field can be set to enter a sequential number automatically as each record is added to the table.  Designating such a field as the primary key for a table is the simplest way to create a primary key.  If you don’t set a primary key before saving a newly created table, Microsoft Access will ask if you want it to create a primary key for you.

To define the primary key:

1. Open the table in Design view.  To do this, click on the table you want to open and click Design.

2. Select the field or fields you want to define as the primary key.  To select the field, click on the gray box to the left of the field name—this is referred to as the row selector.

3. To select multiple fields, hold down the CTRL key and then click the row selector for each field.

4. Click the key icon on the toolbar.  Notice that a key appears at the left of the row, showing that the field is designated as the primary key field.

Working With Tables

Table Wizard

To create a table by using the wizard:

1. Select the tab labeled Create table by using wizard.

2. Click Open. 

3. Choose the table type and fields for the type of table you want to create.  Click Next.

4. Create a name for your table and set the primary key.  If you choose to set the primary key yourself, be asked to define the primary key in the next window.  Click Next.

5. Determine relationships for the table.  If this is the first table created in your database you will not have any tables to select to build relationships, if you have more than one table in the database you can select tables to build relationships.  Click Next.

6. Choose your final option.  

· If you choose to modify the table design, after clicking Finish the Table Design window will automatically open for you to modify.

· If you choose to enter data directly into the table, after clicking Finish the table will open in database view for you to start entering data.

· If you choose to enter data into the table using a form the wizard creates, after clicking Finish an automatically generated form will open where you can start to enter data.

Notes:  

· You can enter data in the database table either by inputting information directly onto the datasheet or by using a form.

· To replace text completely, position your cursor in the box that needs to be modified.  Highlight the entire box and re-key the text.

· To add or delete text within a box, position your cursor in the box that needs to be modified.  Place the I-beam where you want to add or delete a character(s).  Make the revision.

Import Data

A new table can be created using existing data by importing or linking data from another Microsoft Access database or data in a variety of file formats from other programs.  

To create a table by importing data:
1. In the Database window, click the Tables Tab, and then click New.

2. Choose Import Table and click OK.

3. Choose the filename containing the table you want to import, click Import.

4. Choose which database objects you are going to import, click OK.

Working With Forms
Forms provide a user-oriented, convenient interface for data input.  Not only will you see the field identifiers, but also the form looks like a paper form, a familiar mode of data entry.  Forms can be created in the following formats:

AutoForm

The easiest way to create a form is to use the AutoForm feature.  AutoForm will crate a form that will include all fields and records in the underlying table or query. 

To create a form using AutoForm:

1. From the Database window, click Forms [image: image3.bmp] under Objects.

2. Click the New button on the toolbar.

3. In the New Form dialog box, click one of the following wizards: 

· AutoForm: Columnar–Each field appears on a separate line with a label to its left.

· AutoForm: Tabular–The fields in each record appear on one line, with the labels displayed once at the top of the form.

· AutoForm: Datasheet––The fields in each record appear in row-and-column format, with one record in each row and one field in each column. The field names appear at the top of each column. 

4. Select the table or query that contains the data you want to base your form on.

5. Click OK. 

Form Wizard

Access Wizard easily creates a form based on the database objects you have built.  You will determine the form options by answering questions when prompted by the Form Wizard.

To create a form using the wizard:

1. From the Database window, select the Forms Tab, choose Create Form by Using Wizard.

2. Click Open.

3. Choose the tables and fields you want to include on the form, click Next.

4. Select the format for the form, click Next.

· Single-column (Columnar):  Displays the data from each record in a single column on a separate line with the label displayed to the left.  The records are displayed vertically on the page.

· Tabular:  Displays the data in rows and columns from left to right.  Labels appear at the top of each column and each row represents a new record.

· Datasheet:  Displays the data as it appears in the table.

5. Assign a style for the form, then click Next. 

6. Name the form and choose how you want to view it, then click Finish.

· If you choose Open the Form To View or Enter Information, when Finish is clicked the Form window will automatically open for you to start entering data.

· If you choose Modify the Form’s Design, when Finish is clicked the Form Design window will open so you can modify the form design.

Working With Forms

Opening a Form

When you open a form, you are opening it so that you can enter data on the form, you cannot modify the form design when opening the form.

To open a form:

1. From the Database window, click Forms under Objects.

2. Click the form you want to open.

3. Click the Open button to open the form in Form view, or the Design button to open the form in Design view.   Once you've opened a form, you can easily switch among the three views of the form by clicking the View button on the toolbar.

Modifying a Form Design

To modify the design of the form, you need to open the form design view.

To modify the design of a form:

You can use the following techniques to customize a form that you created with a wizard or to create a form entirely on your own.  All changes to the design of the form are done in the Design view.  

1. Click on the formatting options contained in the Formatting Toolbar.

2. To change a background, click in the Design view of a form, right-click with the mouse, choose Fill/Back Color and click on the color you want.

3. To size form controls, click on the control box and drag the sizing handles until the control is the size you want.  To align boxes, select multiple boxes, right-click with the mouse, choose Align and choose the desired alignment.

4. Change data labels on the form.  To change data labels, double-click directly into a label box and edit the text.

Headers and Footers

You can add headers and footers to appear on each page of a form.

To add or remove a form header and footer or a page header and footer:

1. Open the form in Design view.

2. Click Form Header/Footer or Page Header/Footer on the View Menu. 

3. Key in the text you want to appear.

Predefined Forms

You can format a form using predefined formats.

To format a form by using predefined formats:

1. Open a form in Design view.

2. Do one of the following:  If you want to format the entire form, click the form selector.  If you want to format a particular section, click the section selector.  If you want to format one or more controls, select the controls. 

3. Click AutoFormat [image: image4.bmp] on the toolbar.

4. Click one of the formats in the list, choose any options.

Working With Reports
Generating a report allow you to present your data in a printed, organized format. You can design the report so that only the information you want included is generated.

AutoReport

The easiest way to create a report is to use the AutoReport feature.  AutoReport will crate a report that will include all fields and records in the underlying table or query. 

To create a report using AutoReport:

1. From the Database window, choose Reports under Objects.

2. Click the New button.

3. In the New Report dialog box, click one of the following wizards: 

· AutoReport: Columnar–Each field appears on a separate line with a label to its left.

· AutoReport: Tabular–The fields in each record appear on one line, and the labels print once at the top of each page. 

4. Click the table or query that contains the data you want to base your report on.

5. Click OK. 

Report Wizard

Access Wizard easily creates a report based on the database objects you have built.  You will determine the report options by answering questions when prompted by the Report Wizard.

To create a report using the wizard:

1. From the Database window, select the Report Tab, choose Create Report by Using Design Wizard.

2. Click Preview.

3. Choose the tables and fields you want to include in the report, then click Next.

4. Add any grouping levels, then click Next.  (Note:  Grouping levels allows you to group pieces of information together on a report.)

5. Choose the order of how you would like records to appear on the report, then click Next.

6. Select the format for the form and choose the page orientation, then click Next.

7. Assign a style to the report, then click Next.

8. Name the report and choose how you want to view it, then click Finish.

· If you choose Preview the Report, when Finish is clicked the report will open with the defined options.

· If you choose Modify the Report’s Design, when Finish is clicked the Report Design window will open so you can modify the report design.

Working With Reports

Opening a Report

When opening a report, the only thing you can do is view the report, you cannot make changes to the design or the data contained within the report.  Use the Report Design view to change the design of the report.  To change the data, you will need to open the table or form and revise data.

To open a report:

1. From the Database window, click Reports under Objects.

2. Click the report you want to open.

3. Click the Preview button to preview the report, or the Design button to open the report in Design view.   
Modifying a Report

All changes to the report design will need to be done using the Report Design view.

To modify the design of a report:

You can use the following techniques to customize a report that you created with a wizard or to create a report entirely on your own.  All changes to the design of the report are done in the Design view.  

1. Select formatting options including: font, size, bold/italics/underlining of text, text placement, and text color.  To change text formatting click on the text and click on the formatting options contained in the Formatting Toolbar.

2. Add background to report  To change a background, click in the Design view of a report, right click the mouse button, choose Fill/Back Color and click on the color you want.

3. Size and align report controls (label boxes and the text boxes where the data is stored on the report).  To size report controls, click on the control box and drag the sizing handles until the control is the size you want.  To align boxes, select multiple boxes, right click the mouse button, choose Align and choose the desired alignment.

4. Change data labels on the report.  To change data labels, double-click directly into a label box and edit the text.

Headers and Footers

Headers and footers can be included for text and graphics that you want included on each page in the report.

To add or remove a report header and footer or a page header and footer:

1. Open the report in Design view.

2. Click Report Header/Footer or Page Header/Footer on the View Menu. 

3. Key in the text you want to appear.

Working With Reports

Predefined Reports

The report can be automatically generated using predefined formats.
To format a report by using predefined formats:

1. Open a report in Design view.

2. Do one of the following:  If you want to format the entire report, click the report selector.  If you want to format a particular section, click the section selector.  If you want to format one or more controls, select the controls. 

3. Click AutoFormat [image: image5.bmp] on the toolbar.

4. Click one of the formats in the list, choose any options.

Working With Queries

A query is a question you ask Access about your data.  Microsoft Access gathers the data that answer your question and displays them in a separate output.  Queries allow you to view one or more pieces of data in a snapshot, view only the data that you identify.

Simple Query 

Microsoft Access can often create a query for you so you don't have to design one from scratch. 

To create a simple select query with a wizard:
The Simple Select Query Wizard creates queries that retrieve data from the fields you specify in one or more tables or queries. Depending on what you want, you can ask the wizard to perform such functions such as, calculating sums, counting, and determining average values for groups of records or all records. 

1. From the Database window, click Queries under Objects, and then click Create query by using wizard.

2. Click Open.

3. Choose the name of the table or query you want to base your query on, and then select the fields whose data you want to retrieve, click Next.

4. Choose your summary options, click Next.

5. Name the query and choose how you want to view it, click Finish.
· If you choose to open the query to view information, after clicking Finish the query will open with the set criteria.

· If you choose to modify the query’s design, after clicking Finish the Query Design window will open so you can modify the query criteria.

Crosstab Query

Crosstab queries calculate a sum, average, count, or other type of total for data that is grouped by two types of information—one down the left side of the datasheet and another across the top.
To create a crosstab query using a wizard:
1. From the Database window, click Queries under Objects, and then click New on the Database window Toolbar.

2. In the New Query dialog box, click Crosstab Query Wizard.

3. Click OK.

4. Choose the table (or another query) that contains the data you want to run for the query, click Next.

5. Select the heading rows, click Next.

6. Choose the functions you want performed, click Next.

7. Name the query and choose how you want to view it, click Finish.
· If you choose Open the Query To View Information, when Finish is clicked the query will open with the set criteria.

· If you choose Modify the Query’s Design, when Finish is clicked the Query Design window will open so you can modify the query criteria.

Running a Query 

To run a Query:

When you open a query from the Database window, the query will automatically open and run with the most current data.

Using Tools
Filtering Data

Data can be filtered.  Filtering data allows you retrieve a subset of records from an underlying table or query.  Using a filter is easier and less time consuming than using a query, but filters cannot be saved for later reference.  A filter can be done in a table, query, or form.

To filter data in a form:

1. From the Table Datasheet window, click the Filter by Form ([image: image6.wmf]) icon, or select Records/Filter/Filter by Form.

2. Click the field where you want to specify the criteria for the filter.

3. Select the criteria using the drop-down list.

4. Click the Apply Filter/Remove Filter ([image: image7.wmf]) icon, or select Filter/Apply Filter/Sort.

5. To view all the data again, click the Remove Filter icon.

To filter data by selection:

1. From the Table Datasheet window, click the Filter by Selection ([image: image8.wmf]) icon, or select Records/Filter/Filter by Selection.  

2. To view all the data again, click the Remove Filter icon.

Sorting Data

You can do a simple sort of your data.  A simple sort puts records in order by one field in ascending or descending order.

To sort data:

1. From the Database window, click Tables under Objects, select a table.

2. Click Open.
3. From the open table, click in any cell in the column you want to sort.

4. Click on the Sort Ascending ([image: image9.wmf]) or Sort Descending ([image: image10.wmf]) icon.

Spell Check

You can check your data for spelling errors using the spell check included in Microsoft Access.  Spell check can be run in either the table or the form.  The data generated in a report or query will be based on the text included in the table or form so be sure that the spelling is correct before creating reports or queries for print.

To check the spelling of data in datasheet view:

1. From the Database window, click Tables under Objects, select a table.

2. Select the records, columns, fields, or text within a field whose spelling you want to check. 

3. From the Tools Menu, choose Spelling. 

4. When a possible spelling error has been detected, correct the spelling by choosing one of the recommended suggestions or by keying in new text, go through each error until you have made all corrections.
5. When the spelling check is complete, it will automatically close.

To check the spelling of data in Form view:

1. From the Database window, click Forms under Objects, select a form.
2. Follow the steps 2 through 5 above.

Printing Database Objects

Setting Up the Database Object 

Prior to printing a database object, you will want to specify page setup and printing options.

To set page setup options for a table, query, form, or report:

1. Open the database object in one of the following views: 

· Open a table or query in Datasheet view or Print Preview.

· Open a form or report in any view (or from the Database window). 

Note:  Page setup options aren't available for macros or modules. 

2. On the File Menu, click Page Setup.

3. Click the following tabs for the options you want to set: 

· Margins:  To set margins.

· Page:  To set orientation, paper size, and printer.

· Columns:  To set number, size, and layout of columns (for forms and reports). 

4. Click OK. 

Note:  Microsoft Access stores the settings for page setup options with a form or report, so you set these options only once for each form or report. For tables, queries, and modules, you must set page setup options every time you print. 

Previewing the Database Object 

To preview a form from design view, form view, or datasheet view:

1. Click Print Preview [image: image11.bmp] on the toolbar.

2. To return to Design view, Form view, or Datasheet view, click the View button on the toolbar. 

To preview a form from the database window:

1. Click the Database Object you would like to preview.

2. Choose the specific item you want to preview.

3. Click Print Preview [image: image12.bmp] on the toolbar. 

Printing the Database Object 

To print a form or report from design view, form view, or datasheet view:

1. Open the database object. 

2. On the File Menu, click Print.

3. In the Print dialog box, select the printing options you want. 

Note:  How Microsoft Access prints a form depends on the view from which you print it.
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